Disclaimer

Every effort has been made to ensure that the screen graphics and the exercises in this document are up to date and accurate. However, due to the frequency of Web updates, they may have changed.
Preface

The treatment and management of HIV/AIDS continues to evolve with new scientific breakthroughs, treatment discoveries, and management challenges. People living with AIDS and those who care for them have difficulty keeping up with the latest information on HIV/AIDS screening, testing, prevention, treatment and research. The National Library of Medicine® (NLM), National Institutes of Health (NIH), has a wealth of health information resources freely available on the Internet to address these needs.

The HIV/AIDS Information Resources from the National Library of Medicine workbook is designed to provide valuable health information resources from NLM and other reliable sources to increase awareness of the abundance of treatment information and educational materials that are available on the Internet. These resources will meet the needs of community-based organizations and AIDS service organizations, as well as others that need the most accurate and up to date information regarding the management of HIV and AIDS, including clinical trials, HIV/AIDS drugs, treatment guidelines, and medical literature.

This workbook contains a brief summary of NLM resources followed by search exercises using realistic scenarios. Additional resources, selected for the quality and relevant content, are also included for your reference.

The National Library of Medicine, a part of the National Institutes of Health, is the world’s largest medical library with a mission to collect and disseminate trustworthy, reliable health information to health care professionals, researchers, patients, and the public.
This page was intentionally left blank.
# Table of Contents

Preface ............................................................................................................................................ iii

Section 1:  Introduction
Introduction ........................................................................................................................................ 3

Section 2:  Basic Internet Skills
Basic Internet Skills ........................................................................................................ 7
Selected World Wide Web Search Tools ........................................................................ 13

Section 3:  Navigating the Web for Health Information
Finding Quality Health Information on the Internet ...................................................... 17
Savvy Health Surfing Search Exercises ....................................................................... 19

Section 4: AIDSinfo®
AIDSinfo ....................................................................................................................................... 23
AIDSinfo Search Exercises ............................................................................................... 27

Section 5: ClinicalTrials.gov®
ClinicalTrials.gov ........................................................................................................ 39
ClinicalTrials.gov Search Exercises ................................................................................ 43

Section 6: MedlinePlus®
MedlinePlus .................................................................................................................. 51
MedlinePlus Search Exercises ....................................................................................... 55

Section 7: PubMed®/MEDLINE®
PubMed/MEDLINE ........................................................................................................ 65
MEDLINE and MedlinePlus: What Is the Difference? .................................................... 71
PubMed/MEDLINE Search Exercises ............................................................................. 73
Saving and Printing Records in PubMed ...................................................................... 79

Section 8: Public Health Partners
PH Partners ..................................................................................................................... 85
PH Partners Search Exercises ......................................................................................... 87

Section 9: DIRLINE®
DIRLINE ............................................................................................................................ 93
DIRLINE Search Exercises ............................................................................................. 97
Section 10: Additional Resources
National Minority AIDS Council ................................................................. 103
Office of AIDS Research ............................................................................ 105
Selected CDC Web Sites ........................................................................... 107
Selected Internet Resources in HIV/AIDS .................................................. 109
Selected Internet Resources in Health ......................................................... 113

Savvy Health Surfing (a pullout reference card) .............................................. (final page)

Contact NLM for Assistance ....................................................................... (inside back cover)
Introduction
Introduction

Why the National Library of Medicine®?

The National Library of Medicine (NLM) is the world’s largest biomedical library and part of the National Institutes of Health. The health information that NLM makes available on the Internet is free, easily and quickly accessible, and of the highest quality and reliability.

NLM Online Resources Covered in this Workbook

The following key medical information resources are covered in depth with search exercises and suggested solutions that can be used for hands-on practice:

- **AIDSinfo®**—a service that offers health care professionals and consumers access to the latest, federally approved HIV/AIDS medical practice guidelines, clinical trials, and other research information. *infoSIDA* is the Spanish-language counterpart to AIDSinfo

- **ClinicalTrials.gov**—regularly updated information about federally and privately supported clinical research for a wide range of diseases and conditions, including locations and phone numbers for more details

- **MedlinePlus®**—a consumer health information resource, that includes full-text documents on medical topics, information on drugs, a medical encyclopedia, medical dictionaries, and directories of libraries, hospitals, and health care professionals

- **PubMed®/MEDLINE®**—access to references for articles published in journals in the fields of medicine and the life sciences

- **Public Health Partners**—a collaboration of U.S. government agencies, public health organizations, and health sciences libraries which provides timely, convenient access to selected public health resources on the Internet

- **DIRLINE®**—an online directory of health-related organizations offering information and referral for many diseases and conditions
This page was intentionally left blank.
Basic Internet Skills
Basic Internet Skills

What is the Internet? . . . the World Wide Web?

The Internet and the World Wide Web (Web) are not the same thing. The Internet is a worldwide network of computer networks that can communicate with each other using languages called protocols. The Web is only one portion of the Internet, the best known part, and is viewed with a graphical interface software called a browser.

Three commonly used browsers are Internet Explorer, Google Chrome, and Firefox. Before you can use the Internet, you must contract with an Internet Service Provider (ISP). An ISP supplies access to the Internet over a telephone line, a Digital Subscriber Line (DSL), satellite service, or cable.

See the Additional Resources section for links to Web sites with more detailed information on these topics.

Basic Navigation

Every Web site has a unique address, called a Uniform Resource Locator (URL). If you know the URL, you can type it directly into the address field of your browser. For example:

Let’s look more closely at the URL. The basic components of a URL are:

- the protocol name (http://)
- the server name (nlm.nih.)
- the domain name (gov)

This basic URL will get you to a Web site’s homepage. Not all URLs begin with “www.” For example, the URL for the NLMs MedlinePlus Web site is http://medlineplus.gov

If you are going to a sub-page or a document on a Web site’s server, there will be additional components, as in the URL shown below: a directory name (about) and/or a filename: (visitor.html).

Every Web browser has a navigation toolbar at the top of the page with buttons and menus that you can use to perform commands. The toolbar can be customized to make the buttons large or small and to add, remove, or change the order of the buttons.
Microsoft Explorer’s navigation toolbar looks like this:

- **Back and Forward**
  - Back ............ to return to the last page you viewed
  - Forward ...... to return to a page you viewed before clicking the Back button
  - Stop .......... to cancel opening a new page
  - Refresh ...... to reopen (reload) the page
  - Home .......... to go to your starting page (can be customized)
  - Search ....... to find another Web page to view
  - Favorites .... to go to pages you have “bookmarked”
  - History ........ to view pages you have visited recently
  - Print ............ to print the page you are viewing
  - Page ........... to e-mail the page to someone

In addition to the buttons on the toolbar, there are menus that can be used to perform many more functions. The buttons are actually shortcuts to some of the menu commands.

- **File, Edit, View, Favorites, Tools, Help**

  Click… **Edit**, and then **Find** (on This Page)… to find key words on the page you are viewing
  View, and then **Text Size**… to increase or decrease the text size on the page
  Favorites… to bookmark a Web page or to organize your bookmarks
  Tools, and then **Internet Options**… to customize your browser
  Help… for help in how to use the Internet with your Web browser

**Example: Bookmarking the National Library of Medicine Web site using the Favorites menu.**
► Go to http://www.nlm.nih.gov
► Click the Favorites menu and select Add to Favorites

Example: Changing your browser’s homepage to the National Library of Medicine.
► Click the Tools menu and select Internet Options…

► Type http://www.nlm.nih.gov in the address box
► Click Apply then OK
► Or… Go to the page you want to use as your homepage, click Tools/Internet Options, then click the Use Current button below the address box

Cookies

When you visit any Web site, it may place a small text file, known as a cookie on your computer. The cookie allows the Web site to remember specific information about your visit while you are connected or when you return to that site. The cookie makes it easier for you to use the dynamic features of Web pages. Cookies from NLM Web pages only collect information about your browser's visit to the site; they do not collect personal information about you.

Printing Web Pages

To print the Web page you are viewing, click the print button on the navigation toolbar or click the File menu and select Print… but be aware that the page may not print as it appears on screen. For this reason, it is best to print via the file menu, which will open your print dialog box and allow you to set preferences. Using the print button will send the page directly to your default printer using its default settings.

Tips for printing Web pages:

1) One Web page can be many printed pages.
2) Use Print Preview (from the File menu) to see how many pages will print.
3) The Web page may have “frames.” Click your cursor in the frame you wish to print before printing.

About Adobe PDF and Adobe Reader

Adobe Portable Document Format (PDF) is a universal file format that has become an international standard for electronic document distribution. Created by Adobe Systems, Inc., PDF allows users to print files as they appear on screen, keeping page numbering and graphics intact. Adobe offers the free Adobe Reader® program so that anyone can view and print PDF files. To install Adobe Reader, go to http://www.adobe.com/downloads and click the Get ADOBE® READER® icon.

Tip: Click System requirements to review the system requirements before downloading and installing the program. To continue, click the Download Now link below Next Steps and follow the online instructions.

Adobe Reader has its own toolbar with buttons that allow you to print, save, e-mail, go to the next or previous page, select text and graphics for copying, zoom, sign, and find a word or phrase in the document. The page indicator is also in the toolbar.

Additional buttons on the left allow you to navigate the document, view attachments, and view/reply to any comments left by the person who sent the document to you.

Tip: Use the buttons on the Adobe Reader toolbar (not your Web browser’s toolbar) to Print and Save PDF files.

World Wide Web Search Tools

The primary tools for finding information on the Web are search directories, search engines, and metasearch engines. For a specific list of selected World Wide Web search tools, see page 13.

► Search Directory: Organized by subject and generally smaller than search engines because they are edited by people.

► Search Engine: A software program that indexes documents based on search requests by users. To be included, sites must be submitted by their owners.

► Metasearch Engine: A search engine that queries other search engines and combines the results into one list.
How to Construct a Search

Before executing a search, you should first formulate your search question. For example, you could ask:

► What information is available about treatment options for children with HIV?

Next, identify the important concepts within the question:

► children, hiv, treatment

Then, identify the search terms to describe those concepts:

► children, hiv, treatment

Consider synonyms and variations of those terms:

► children, childhood, juvenile, youth, child, adolescent

In most cases, you want your search results to contain all terms, and the default for most databases is to retrieve records that contain all terms. When entering your chosen terms in the search box, separate them by one space as in the following example:

yor SEARCH STRATEGY

PLAN:

► What are you looking for?
► Is the Web the best place to find the information?

ACT:

► Know which search tools to use.

REVIEW:

► Did the information you find answer your question?
► Do you need to redefine, narrow, or expand your topic?

Boolean Searching

In Boolean logic, the commands “AND,” “OR,” and “NOT” are used to include or exclude search terms. In the matrix below, each search term is represented by a circle to illustrate the concepts.
Narrowing a Search

To narrow a search on apples:

► Add more words: apples macintosh
► Search as a phrase: “apples macintosh”
► Exclude words: apples NOT macintosh

Broadening a Search

To broaden a search on macintosh apples:

► Use a broader term: apples
► Use fewer words
► Do not search as a phrase
► Do not exclude words

Additional Resources

For further information, we recommend these additional resources:

► Browsers (CNET Download.com)
download.com/2001-2137-0.html

► General Internet Information
nnlm.gov/scr/technology/internetfaq1.html

► Internet Information Access Resources
nnlm.gov/scr/technology/internetfaq2.html

► Internet Basics (Seniors)
nihseniorhealth.gov/toolkit/toolkitfiles/pdf/Module_1.pdf
Selected World Wide Web Search Tools

Major Search Directories and Search Engines

► altavista.com
► ask.com
► bing.com
► google.com
► hotbot.com
► msn.com
► yahoo.com

Meta Search Engines

► dogpile.com
► infogrid.com
► ixquick.com
► mamma.com
► surfwax.com
► vivisimo.com

Miscellaneous

► Search Engine Watch – Information for Web Designers
  searchenginewatch.com

► CataList – Reference Site for Listserv lists
  catalist.us/
This page was intentionally left blank.
Navigating the Web for Health Information
Finding Quality Health Information on the Internet

The World Wide Web contains an abundance of free health information available 24 hours a day. Finding health information online is easy, but how do we know that the information we find is reliable and trustworthy?

Evaluating Internet Resources

NLM is a good place to start to find trustworthy, up-to-date health information. Beyond that, there are some important questions you can ask yourself to determine if a site is trustworthy. Briefly, the categories you should consider are the following:

► Authority and Accuracy
► Coverage
► Currentness
► Objectivity
► Design Features

“Savvy Health Surfing,” developed by the National Library of Medicine, contains a complete list of the questions that should be asked in each category. You will find this pullout reference card in the back of this workbook.
Additional Resources

For further information, we recommend these additional resources:

► HON Code of Conduct for Medical and Health Web Sites
  www.hon.ch/HONcode

► Evaluating Internet Health Information: A Tutorial from the National Library of Medicine
  nlm.nih.gov/medlineplus/webeval/webeval.html

► MedlinePlus—Evaluating Health Information
  nlm.nih.gov/medlineplus/evaluatinghealthinformation.html

► National Network of Libraries of Medicine—Is this health information good for me?
  nnlm.gov/pnr/hip/criteria.html
  (en Español: nnlm.gov/pnr/hip/informacion.html)

► Quackwatch
  quackwatch.com
## Savvy Health Surfing Exercises

Review the following Web sites and determine if each is reliable according to the Savvy Health Surfing criteria discussed in class.

<table>
<thead>
<tr>
<th>Authority/Accuracy</th>
<th>Coverage</th>
<th>Currentness</th>
<th>Objectivity</th>
<th>Design Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. thinktwice.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. tourette13.tripod.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. healthfree.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. malepregnancy.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. healthcentral.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. drugs.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. thebody.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. nwsids.org</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. medical-library.net</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. webmd.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. drclark.net</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. aaemonline.org</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. pslgroup.com/dg950925.htm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14. amaasportsmed.org</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15. bonetumor.org</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16. biausa.org</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17. sparkaction.org</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18. curezone.com</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This page was intentionally left blank.
AIDSinfo is a U.S. Department of Health and Human Services Web site that provides the latest federally approved treatment guidelines for health care professionals as well as additional information on treatment, prevention, and research for health care providers and consumers. A comprehensive Spanish version (infoSIDA) is also available.
Organization and Features

AIDSinfo is organized around six main categories:

► **Guidelines**—federally approved HIV treatment and prevention guidelines for HIV infection and AIDS-related illnesses, including the prevention of HIV transmission from occupational exposure, mother-to-child transmission during pregnancy, and prevention and treatment of HIV-related opportunistic infections

► **Clinical Trials**—information on federally and privately funded clinical trials evaluating experimental drugs and other therapies for adults and children at all stages of HIV infection

► **Drugs**—records for FDA-approved and investigational HIV/AIDS-related drugs: Patient and Health Professional version and Spanish version

► **HIV/AIDS Health Topics**—a comprehensive collection of links to government resources about HIV/AIDS-related topics

► **Education Materials**—resources for both patients and health care providers on HIV/AIDS-related topics

► **Mobile Resources and Tools**—a variety of tools optimized for mobile devices and designed to provide access to the most popular features, such as the guidelines, clinical trial search tools, and drug database.

Additional features offered in AIDSinfo include the following:

► **HIV/AIDS Glossary**—definitions of HIV/AIDS-related terms in English and Spanish

► **Android and iPhone Glossary App**—downloadable AIDSinfo Glossary application for on-the-go access to the terms found in the AIDSinfo Glossary of HIV/AIDS-Related Terms

► **HIV/AIDS News**—database of HIV/AIDS-related news from federal agencies, including an archive of the AIDSinfo e-newsletter At-a-Glance

► **Publications**—print, electronic, and PDF versions of AIDSinfo publications (Single copies of print publications are free.)
Searching AIDSinfo

To search AIDSinfo, you can type your search term in the search box at the top of any AIDSinfo page or search directly for the type of information you want by clicking the appropriate navigation tab.

Clinical Guidelines Portal

Search by keywords in the Adult and Adolescent Guidelines or Pediatric and Perinatal Guidelines, or browse the current and archived guidelines.

AIDSinfo Clinical Trials Database

Search by key words, conditions, drugs, or locations, or browse by trial category.

AIDSinfo Drug Database

Search by drug name, drug class, or approval status, or search alphabetically.

Stay Connected

Mobile Version

The AIDSinfo mobile site contains the same popular features found on the full AIDSinfo Web site, optimized for display on mobile devices. The mobile version is available at m.aidsinfo.nih.gov. Spanish mobile available at m.infosida.nih.gov

Apps

Download AIDSinfo mobile apps, created specifically for Apple and Android phones and tablets. Download apps at aidsinfo.nih.gov/apps

Follow us on Twitter

Twitter provides AIDSinfo users with short, timely, and instantly updated health news and information. Join and follow at twitter.com/aidsinfo

Get E-mail Updates

Subscribe to the AIDSinfo weekly e-newsletter, At-a-Glance, to receive notice of Web site updates, HIV/AIDS news, and treatment guideline updates. aidsinfo.nih.gov/e-news
Facebook

Facebook provides AIDSinfo users with a simple way to stay up to date with the latest HIV/AIDS information. facebook.com/AIDSinfo

Subscribe to RSS

AIDSinfo offers the information in the weekly newsletter and Drug Database through Really Simple Syndication (RSS) feeds. aidsinfo.nih.gov/Other/rss.aspx

Additional Resources

For further information, we recommend these additional resources:

► AIDSinfo Brochure
   aidsinfo.nih.gov/contentfiles/ai_brochure.pdf

► AIDSinfo Glossary
   aidsinfo.nih.gov/ContentFiles/GlossaryHIVrelatedTerms.pdf

► Glosario del VIH/SIDA
   aidsinfo.nih.gov/ContentFiles/SpanishGlossary_sp.pdf

► infoSIDA
   aidsinfo.nih.gov/infoSIDA
Search Example: Locate the latest guidance on HIV counseling, testing, and referral.

Suggested Solution:

▸ Go to aidsinfo.nih.gov

▸ Click Guidelines

▸ Click HIV Counseling, Testing, and Referral Guidelines

▸ Click Revised Recommendations for HIV Testing of Adults, Adolescents, and Pregnant Women in Health Care Settings
Guidelines

Search Exercises

Exercise 1: Using the navigation bar locate the guidelines for caring for HIV infected individuals following a disaster.

Suggested Solution:

- Click the **Guidelines** tab at the top of the page
- Click **Guidelines on Care for HIV-Infected Residents Displaced from Disaster Areas** under **Care for Disaster Displaced HIV-Infected Patients**
- Review the guidelines and then use the browser's **Back** button to return to the Clinical Guidelines Portal

Exercise 2: Conduct a guideline search for initiating antiretroviral therapy in treatment-naive adult and adolescent patients.

Suggested Solution:

- Type **treatment naive** in the **Search** box
- Select **Adult and Adolescent Guidelines** from the drop-down menu under **Guideline Search**
- Click **Search**
- Click **Initiating Antiretroviral Therapy in Treatment-Naive Patients**
Exercise 3: What are the guidelines for incorporating HIV prevention into the medical care of HIV positive patients?

Suggested Solution:

Click Guidelines
Click Guidelines on Incorporating HIV Prevention into Medical Care under Current Guidelines
Click Incorporating HIV Prevention into the Medical Care of Persons Living with HIV (HTML)
Review the guidelines and close the CDC window

Exercise 4: Locate the guidelines for nonoccupational exposure to HIV. Next, view the slide set.

Suggested Solution:

Click Guidelines
Click Nonoccupational Postexposure Prophylaxis (nPEP) under Current Guidelines
Click Slide Sets HTML
Click Antiretroviral Postexposure Prophylaxis After Sexual, Injection-Drug Use, or Other Nonoccupational Exposure to HIV in the United States in the pop-up window
The pop-up window opens to the AIDS Education Training Centers (AETC) National Resource Center.
Click Antiretroviral Postexposure Prophylaxis After Sexual, Injection-Drug Use, or Other Nonoccupational Exposure to HIV in the United States PPT [365 KB] and follow the on-screen directions
Review the slides and close the PowerPoint window
Use the browser’s Back button to return to the Clinical Guidelines Portal.

Exercise 5: Review the most recent Guidelines News topic. Next, subscribe to the AIDSinfo weekly e-newsletter (optional).

Suggested Solution:

Click Guidelines
Click the first topic under Guidelines News to the right of the page
Review the information and close the pop-up window or use the browser’s Back button to return to the Clinical Guidelines Portal
Click E-News at the bottom of the page and follow the on-screen instructions to subscribe to AIDSinfo At-a-Glance
Exercise 6: Perform a Guideline search of your choice.

Clinical Trials

Exercise 7: Oral candidiasis is a common condition in HIV-infected individuals. Are there any clinical trials studying this condition?

Suggested Solution:
- Click Clinical Trials
- Type oral candidiasis in the Search box
- Click Search
- Review clinical trial(s) of your choice

Exercise 8: Are there any clinical trials researching the effectiveness and safety of Dapivirine in preventing HIV-infection in women. Next, display only the studies that are recruiting.

Suggested Solution:
- Click Clinical Trials
- Click Advanced Search
- Type prevention in the Search box
- Type dapivirine in the Interventions search box
- Select Studies with Female Participants from the Gender drop-down menu
- Click Search
- Review the clinical trial record(s)
- Select Studies Seeking New Volunteers from the Filters Results drop-down menu
- Review the clinical trial record(s) and close the ClinicalTrials.gov window

Exercise 9: Are there any Phase 3 clinical trials studying the use of cognitive behavioral therapy in individuals infected with HIV?

Suggested Solution:
- Click Clinical Trials
- Click Advanced Search
- Type cognitive behavioral therapy in the Interventions search box
- Select Phase 3 in the Phase: search field
- Click Search
- Review the clinical trial record(s) and close the ClinicalTrials.gov window
Exercise 10: Using the “Search by Category” feature, locate clinical trials that are studying Long-term Nonprogressors.

Suggested Solution:
- Click Clinical Trials
- Click Long-Term Nonprogressors/Elite Controllers under Specific Populations
- Review clinical trial(s) of your choice

Exercise 11: Review the most recent Clinical Trial News topic. Next, review the “What is an HIV/AIDS Clinical Trial” fact sheet.

Suggested Solution:
- Click Clinical Trials
- Click the first topic under Clinical Trial News to the right of the page
- Review the information and close the pop-up window or use the browser’s Back button to return to the HIV/AIDS Clinical Trials Portal
- Click the Clinical Trials tab at the top of the page
- Click What is an HIV/AIDS Clinical Trial (pdf) under Download Education Materials
- Review the fact sheet and close the pop-up window
  - The fact sheet is also available in the Education Materials.

Exercise 12: Find all HIV/AIDS trials in your home state.

Suggested Solution:
- Click Clinical Trials
- Click Advanced Search
- Select a state from the State drop-down menu
- Click Search
- Review the clinical trial record(s) and close the ClinicalTrials.gov window
Drug Category

Exercise 13: The U.S. Food and Drug Administration (FDA) recently approved a generic formulation of Ziagen, a Nucleoside Reverse Transcriptase Inhibitor. What is the generic name?

Suggested Solution:
- Click Drugs
- Type ziagen in the Search box under Search the Drug Database
- Click Search
- Review the Other Names section

Exercise 14: Using the A-Z Index, review the Spanish fact sheet for Combivir.

Suggested Solution:
- Click Drugs
- Click C under the A-Z Index
- Click Combivir
- Click Español to the right of the page above Drug News
- Click English to return to the AIDSinfo Drug Database

Exercise 15: Truvada has been approved as a pre-exposure prophylaxis (PrEP). What are the side effects of taking this drug?

Suggested Solution:
- Click Drugs
- Type truvada in the Search box under Search the Drug Database
- Click Search
- Review the information under What side effects can Truvada cause?

Exercise 16: Are heart problems a side effect of Maraviroc? Use the A–Z Index.

Suggested Solution:
- Click Drugs
- Click M under the A–Z Index
- Click Maraviroc
- Scroll to What side effects can maraviroc cause?
Exercise 17: View the list of investigational Integrase Inhibitors. Review the clinical trial status of one of the investigational drugs.

Suggested Solution:
- Click **Drugs**
- Select from the **Integrase Inhibitors Drug Class** drop-down menu
- Select **Investigational** from the **Approved Status** drop-down menu
- Click **Search**
- Click an **investigational Integrase Inhibitor** of your choice
- Click **research studies** under **Where can I get more information about clinical trials studying…..?**
- Review the clinical trial record(s) and close the ClinicalTrials.gov window

Exercise 18: The U.S. Food and Drug Administration (FDA) recently approved Complera, a combination drug. What is the mode of delivery and dosing form for Complera?

Suggested Solution:
- Click **Drugs**
- Type **complera** in the **Search** box under **Search the Drug Database**
- Click **Search**
- Click **FDA Label - Tablet (film coated)**
- Click **Dosage & Administration**
- Review the **Dosing Information** section

Exercise 19: Review the most recent Drug News topic.

Suggested Solution:
- Click **Drugs**
- Click the first topic under **Drug News** to the right of the page
- Click **More News** to view archived news topics.
Exercise 20: What is the recommended oral suspension dose of Nevirapine for newborns?

Suggested Solution:

Click **Drugs**
Type **nevirapine** in the **Search** box under **Search the Drug Database**
Click **Search**
Click **FDA Label - Suspension; tablet**

Detailed drug dosing information is provided only in the health professional version (FDA Label).
Click **Dosage & Administration** under **FDA Drug Labels Section**
Review the information for pediatric patients

Health Topics

Exercise 21: Some HIV-infected individuals develop cancer. What information is available on this condition?

Suggested Solution:

Click **HIV/AIDS Health Topics**
Type **cancer** in the **Search** box under **Search HIV/AIDS Health Topics**
Click **Search**
Review topic(s) of your choice

Exercise 22: The population over the age of 50 is one of the fastest-growing groups living with HIV. Locate resources and information for this population.

Suggested Solution:

Click **HIV/AIDS Health Topics**
Click **Specific Populations**
Click **Seniors**
Review topic(s) of your choice

Exercise 23: Use the A-Z Index to locate oral health information.

Suggested Solution:

Click **HIV/AIDS Health Topics**
Click **Q** under **A-Z Index**
Click **Oral Health**
Review topic(s) of your choice

Suggested Solution:
- Click **HIV/AIDS Health Topics**
- Type **statistics** in the **Search Term** box under the **Search HIV/AIDS Topics**
- Click **Search**
- Review record(s) of your choice
- Close the pop-up window or use the browser’s **Back** button to return to the **HIV/AIDS Health Topics** page

Exercise 25: Locate resources for people who take care of HIV-infected individuals.

Suggested Solution:
- Click **HIV/AIDS Health Topics**
- Click **Specific Populations**
- Click **Caregivers**
- Review topic(s) of your choice

**Education Materials**

Exercise 26: Browse the fact sheets.

Suggested Solution:
- Click **Education Materials**
- Click **Fact Sheets**
- Review fact sheet(s) of your choice

Exercise 27: What is polyneuropathy?

Suggested Solution:
- Click **Education Materials**
- Click **Glossary**
- Type **polyneuropathy** in the **Search the Glossary Terms** search box
- Click **Search**
- Review the definition
This page was intentionally left blank.
ClinicalTrials.gov
ClinicalTrials.gov

ClinicalTrials.gov is a Web-based resource that provides patients, their family members, health care professionals, researchers, and the public with easy access to information on publicly and privately supported clinical studies on a wide range of diseases and conditions. ClinicalTrials.gov includes information about the trial’s purpose, who may participate, locations where trials are held, contact information, and whether or not the trial is recruiting participants.

Searching ClinicalTrials.gov

ClinicalTrials.gov study search options and search help resources are located on the homepage in the Search for Studies area and under Find Studies. Users can begin a basic search here, go to the advanced search form, or begin browsing for studies by topic or on a world map. Site visitors can also get help with searching, finding studies with summary results posted on ClinicalTrials.gov, and reading study records.
**Basic Search** - Enter one or more words in the search box labeled **Search** for studies at the top of each page, the Basic Search page, or on the homepage.

**Basic Search Screen**

**Advanced Search** - Focus your search by entering or selecting search terms in multiple fields such as recruitment status, specific conditions, recruitment status, age group of participants, study results, and location. Access the Advanced Search link on the homepage and at the top of every page under the search box.
At the top of the Search Results page, you will see your search terms and the number of studies that were found searching on those terms. Clicking the **Modify this search** link takes you to the Advanced Search form where you can make changes to your search terms and do another search.
Additional Resources

For further information, we recommend these additional resources:

- **Prescription for Success: Consumer Health on the Web**
  [nnlm.gov/training/consumer/prescription](nnlm.gov/training/consumer/prescription)

- **NLM Consumer Health Databases (National Network of Libraries of Medicine)**
  [nnlm.gov/training/consumer/nlm_databases](nnlm.gov/training/consumer/nlm_databases)

- **ClinicalTrials.gov Background Information and Other Consumer Health Information**
  [clinicaltrials.gov/ct2/info](clinicaltrials.gov/ct2/info)

- **ClinicalTrials.gov Online Training**

- **NLM Clinical Alerts and Advisories**
  [nlm.nih.gov/databases/alertsclinical_alerts.html](nlm.nih.gov/databases/alertsclinical_alerts.html)
ClinicalTrials.gov Search Exercises

Search Example: Have clinical trials been conducted using Thalidomide to treat HIV-related illnesses?

Suggested Solution:

► Go to clinicaltrials.gov
► Click Find Studies

► Select Basic Search from the drop-down menu
► The search box labeled Search for studies can be found at the top of any page on this site, the Basic Search page, or on the homepage.

► Type thalidomide HIV in the Search box
► Click Search
Search Exercises

Exercise 1: Locate clinical trials studying oral leukoplakia.

Suggested Solution:

- Click **Find Studies**
- Click **Basic Search**
- Type **oral leukoplakia** in the **Search box**
- Click **Search** and review record(s) of your choice
Exercise 2: Do any clinical trials focus on the impact of the Human Papillomavirus (HPV) on the immune system?

Suggested Solution:
<table>
<thead>
<tr>
<th>Click</th>
<th>Find Studies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>Type</td>
<td>immune system in the Search Terms box</td>
</tr>
<tr>
<td>Type</td>
<td>human papillomavirus in the Conditions box</td>
</tr>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Review</td>
<td>record(s) of your choice</td>
</tr>
</tbody>
</table>

Exercise 3: Is there any evidence that ginger can reduce the risk of developing colorectal cancer?

Suggested Solution:
<table>
<thead>
<tr>
<th>Click</th>
<th>Find Studies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>Type</td>
<td>colorectal cancer in the Conditions box</td>
</tr>
<tr>
<td>Type</td>
<td>ginger in the Interventions box</td>
</tr>
<tr>
<td>Click</td>
<td>Search and review record(s) of your choice</td>
</tr>
</tbody>
</table>

Exercise 4: Locate clinical trials that focus on oral health. Next, limit the results to individuals infected with HIV.

Suggested Solution:
<table>
<thead>
<tr>
<th>Click</th>
<th>Find Studies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>Type</td>
<td>oral health in the Search Terms box</td>
</tr>
<tr>
<td>Click</td>
<td>Search and review records(s) of your choice</td>
</tr>
<tr>
<td>Click</td>
<td>Modify this Search</td>
</tr>
<tr>
<td>Type</td>
<td>HIV in the Conditions box</td>
</tr>
<tr>
<td>Click</td>
<td>Search and review record(s) of your choice</td>
</tr>
</tbody>
</table>
Exercise 5: Are there posttraumatic stress disorder clinical trials that include study results?

Suggested Solution:
Click Find Studies
Click Advanced Search
Select Studies With Results from the Study Results drop-down menu
Type posttraumatic stress disorder in the Conditions box
Click Search and review record(s) of your choice

Exercise 6: How many HIV/AIDS clinical trials are funded by NIH and where are they located? View the studies located in your country or region.

Suggested Solution:
Click Find Studies
Click Advanced Search
Type HIV AIDS in the Conditions box
Select NIH to the right of Funder Type
Click Search
Click On a Map
Click a country or region on the map

Exercise 7: Are there any clinical studies for the drug Ribavirin, which is used to treat Hepatitis C? Next, modify your search results to include only studies that are recruiting.

Suggested Solution:
Click Find Studies
Click Advanced Search
Type hepatitis c in the Conditions box
Type ribavirin in the Interventions box
Click Search
Review record(s) of your choice
Click Modify this search
Select Recruiting from the Recruitment drop-down menu
Click Search and review record(s) of your choice
Exercise 8: Using the Studies by Topic feature, review clinical trials studying herbal and botanical dietary supplements. Review the records for Saw Palmetto.

Suggested Solution:
- Click Find Studies
- Click See Studies by Topic
- Click By Category under Dietary Supplements in the table of contents
- Click Herbal and Botanical
- Click See all to display additional dietary supplements.
- Click Saw Palmetto
- Review record(s) of your choice

Exercise 9: What should people consider before participating in a clinical trial? Next, review the definition of observational study.

Suggested Solution:
- Click About Clinical Studies
- Click Learn About Clinical Studies
- Click Considerations for Participation under Contents
- Review the information
- Click Glossary at the top of the page under the Search box
- Click O
- Review the definition of observational study

Exercise 10: What is a human subjects review board and protocol?

Suggested Solution:
- Click Glossary under the Search for Studies
- Click H
- Review the definition of a human subjects review board
- Click TO TOP
- Click P
- Review the definition of a protocol
This page was intentionally left blank.
MedlinePlus®

MedlinePlus is NLM’s answer to consumer-friendly, authoritative health information. It contains health information especially written for consumers and patients by the National Institutes of Health and other trusted sources. MedlinePlus contains information on health topics, lists of hospitals and physicians, extensive information on prescription and nonprescription drugs, interactive tutorials on many health conditions, links to articles on the latest health news, health information in more than forty languages, and much more.

Features

► Easy-to-read language
► Easy-to-navigate pages
► New links added daily
► No advertising or endorsements
► Latest health news
► Spanish version: medlineplus.gov/spanish
Searching MedlinePlus

To search MedlinePlus, type a word or phrase into the search box. Your initial search results show matches from all of the MedlinePlus content areas. The default display for MedlinePlus searches is a comprehensive list of All Results. The links in the Refine by Type box represent sets of MedlinePlus content areas, known as collections. The collections help you narrow your search by displaying results exclusively from one collection. The Refine by Keyword box organizes your search results into groups based on the most frequent words in the top 200 results.

Browsing MedlinePlus

Health Topics can be browsed alphabetically, by body location and symptoms, disorders and conditions, diagnosis and therapy, health and wellness, and demographic groups. Read about symptoms, causes, treatment and prevention for diseases, illnesses, health conditions and wellness issues. Drugs & Supplements can be browsed alphabetically by brand or generic names. Learn about your prescription drugs and over-the-counter medicines, including side effects, dosage, special precautions, and more. Browse dietary supplements and herbal remedies to learn about their effectiveness, usual dosage, and drug interactions. Videos & Cool Tools contains multimedia health resources, including calculators, quizzes, games, interactive tutorials, and anatomy and surgery videos.
Stay Connected

**Mobile Version**

Mobile MedlinePlus provides authoritative health information for mobile Internet users. It includes a subset of content from the full Web site. It includes summaries for diseases, conditions and wellness topics as well as the latest health news, an illustrated medical encyclopedia, and information on prescription and over-the-counter medications. The mobile version is available at: m.medlineplus.gov

**Get E-mail Updates**

E-mail announcements contain links to new topics and sites on MedlinePlus along with other notices. You can sign up to receive general e-mails covering all health topics, or you can sign up to receive e-mails about specific topics. nlm.nih.gov/medlineplus/listserv.html

**Subscribe to RSS**

Really Simple Syndication (RSS) provides notification when new content, press announcements, and health news articles are published on MedlinePlus. nlm.nih.gov/medlineplus/rss.html

**Follow us on Twitter**

Twitter provides MedlinePlus users with short, timely, and instantly updated health news and information. Join and follow at: twitter.com/medlineplus

**Additional Resources**

For further information, we recommend these additional resources:

- MedlinePlus Frequently Asked Questions
  nlm.nih.gov/medlineplus/faq/faq.html
- Evaluating Internet Health Information: A Tutorial from the National Library of Medicine
  nlm.nih.gov/medlineplus/webeval/webeval.html
- Guide to Healthy Web Surfing
  nlm.nih.gov/medlineplus/healthywebsurfing.html
- Information for Librarians and Trainers
  nlm.nih.gov/medlineplus/training/trainers.html
MedlinePlus® Search Exercises

Search Example: Using the alphabetical list of health topics, review the MedlinePlus AIDS page and locate general information about HIV/AIDS.

Suggested Solution:

► Go to medlineplus.gov
► Click Health Topics

► Click A under Find your topic by first letter

► Click AIDS see HIV/AIDS from the alphabetical list of topics

► Click HIV/AIDS NIH (National Institute of Allergy and Infectious Diseases) under Start Here
Search Exercises

Health Topics

Exercise 1: Using the MedlinePlus search box, locate information on caregiver stress.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>caregiver stress in the Search MedlinePlus search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Go</td>
</tr>
<tr>
<td>Click</td>
<td>a topic(s) of your choice</td>
</tr>
<tr>
<td>Review</td>
<td>the information retrieved and close the pop-up window</td>
</tr>
</tbody>
</table>

Exercise 2: Using the alphabetical list of health topics, review the MedlinePlus Dental Health page and locate patient handouts for adult dental care.

Suggested Solution:

<table>
<thead>
<tr>
<th>Click</th>
<th>Health Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>D under Find your topic by first letter</td>
</tr>
<tr>
<td>Click</td>
<td>Dental Health from the alphabetical list of topics</td>
</tr>
<tr>
<td>Review</td>
<td>the information</td>
</tr>
<tr>
<td>Click</td>
<td>Patient Handouts under For You</td>
</tr>
</tbody>
</table>

Suggested Solution:
- Click Health Topics
- Click A under Find your topic by first letter
- Click AIDS see HIV/AIDS from the alphabetical list
- Click Seniors under For You
- Click Older People and HIV (New Mexico AIDS Education and Training Center) under Seniors
- Close the AIDS InfoNet window and return to the MedlinePlus HIV/AIDS page
- Click MedlinePlus Magazine under For You
- Review an article(s) of your choice

Exercise 4: Using the alphabetical list of health topics, search for information on H1N1 Flu (Swine Flu). Locate a flu clinic in your community.

Suggested Solution:
- Click Health Topics
- Click H under Find your topic by first letter
- Click H1N1 (Swine Flu) from the alphabetical list
- Review the information retrieved
- Click Directories under Reference Shelf
- Click Flu Clinic Locator (American Lung Association) under Directories and follow the on-screen directions
- Review the information retrieved and close the pop-up window

Exercise 5: Using the alphabetical list of health topics, locate information on issues to consider before using an alternative medicine therapy.

Suggested Solution:
- Click Health Topics
- Click A under Find your topic by first letter
- Click Alternative Medicine see Complementary and Alternative Medicine from the alphabetical list
- Click Be an Informed Consumer NIH (National Center for Complementary and Alternative Medicine) under Start Here
- Review the information retrieved and close the pop-up window
Review the additional information on the MedlinePlus Complementary and Alternative Medicine page

**Exercise 6: Find health information for diverse population groups.**

**Suggested Solution:**
- Click **Health Topics**
- Click **Population Groups** under Demographic Groups
- Select the population group of your choice

**Drugs & Supplements**

**Exercise 7: What are the known side effects of Gardasil®, the human papillomavirus (HPV) vaccine? At what age should the vaccine be given?**

**Suggested Solution:**
- Click **Drugs & Supplements**
- Click **G** under Browse by generic or brand name
- Click Gardasil see Human Papillomavirus (HPV) Vaccine (Gardasil)
- Click What are the risks from this vaccine
- Click Who should get HPV vaccine and when

**Exercise 8: I read that Naltrexone is showing promise as an effective Methamphetamine (Crystal Meth) addiction treatment. What is Naltrexone and why is it used for Crystal Meth addiction treatment?**

**Suggested Solution:**
- Click **Drugs & Supplements**
- Click **N** under Browse by generic or brand name
- Click Naltrexone
- Click Why is this medication prescribed?
Exercise 9: Is a Vitamin A supplement possibly effective for reducing the complications of HIV?

Suggested Solution:
- Click Drugs & Supplements
- Click All herbs and supplements
- Click V
- Click Vitamin A
- Click How effective is it?

Exercise 10: People living with HIV/AIDS commonly use the following herbs: Astragalus, Cat’s Claw, Golden Seal, Propolis, and Tea Tree Oil. What is the scientific evidence for use of these drugs? Can these supplements interfere with prescribed medications?

Suggested Solution:
- Click Drugs & Supplements
- Click All herbs and supplements
- Click Astragalus NIH (National Center for Complementary and Alternative Medicine (NCCAM)) in the alphabetical list
- Click What the Science Says
- Review the information under Side Effects and Cautions
- Close the NCCAM window and return to the MedlinePlus Herbs and Supplements page
- Repeat these steps for: Cat’s Claw, Golden Seal, Propolis, and Tea Tree Oil.

Exercise 11: E-mail the HIV/AIDS Medicines page to a client or colleague. Also, register to receive HIV/AIDS Medication updates by e-mail (optional).

Suggested Solution:
- Click Drugs & Supplements
- Click AIDS Medicines under Related Topics
- Review the content on the page
- Click the E-mail icon ( ) and follow the on-screen instructions
- Close the pop-up window and return to the HIV/AIDS Medicines page
- Type your e-mail address in the Get HIV/AIDS Medicines updates by e-mail box
- Click Go and follow the on-screen directions
Videos & Cool Tools

Exercise 12: My doctor has ordered a bronchoscopy to determine if I have pneumocystis carinii pneumonia (PCP). What does this procedure involve? View the bronchoscopy interactive tutorial.

Suggested Solution:
Click Videos & Cool Tools
Click Interactive Tutorials
Click Bronchoscopy under Tests and Diagnostic Procedures
Click Start Interactive Tutorial and follow the instructions
Close the tutorial window and return to the Interactive Health Tutorials page

Exercise 13: Is there a simple way to explain the body’s immune response to HIV and other diseases?

Suggested Solution:
Click Videos & Cool Tools
Click Anatomy Videos
Click Immune response from the alphabetical listing and follow the on-screen instructions

This video plays in QuickTime format. If you do not have QuickTime, you will be prompted to obtain a free download of the software before you view the video.
Click Immune System and Disorders to the right of the page under Related MedlinePlus Page
Click Games under Multimedia & Cool Tools
Click Play the Immune System Defender Game (Nobel Foundation)
Close the pop-up window and return to the MedlinePlus Immune System and Disorders page
Exercise 14: Are there multimedia resources that demonstrate good oral hygiene practices?

Suggested Solution:
- Click Videos & Cool Tools
- Type oral hygiene in the Search all Videos & Tutorials box at the bottom of the page under View latest news
- Click Go
- Click a video or tutorial of your choice and follow the on-screen instructions

The videos open in a second window. If you have a pop-up blocker, you will need to disable it to view the programs.

Exercise 15: Assess your risk for contracting Hepatitis C?

Suggested Solution:
- Click Videos & Cool Tools
- Click All calculators & quizzes to the right under Calculators & Quizzes
- Click H in the alphabetical listing
- Click Hepatitis Risk Assessment (Centers for Disease Control and Prevention) under Hepatitis C and follow the on-screen instructions

The quizzes open in a second window. If you have a pop-up blocker, you will need to disable it to view the programs.

Close the pop-up window and return to the Health Check Tools page

Exercise 16: Using the Medical Encyclopedia, locate an illustration depicting Kaposi’s sarcoma.

Suggested Solution:
- Click Medical Encyclopedia at the bottom of the homepage
- Click K under Browse by first letter of topic
- Click Kaposi’s Sarcoma from the alphabetical list
- Click the graphic of your choice under Images
This page was intentionally left blank.
PubMed®/MEDLINE®
PubMed®/MEDLINE®

PubMed is a database developed by the National Center for Biotechnology Information (NCBI) at the National Library of Medicine and is available free on the Web. PubMed provides free access to MEDLINE, NLM premier bibliographic database containing citations and author abstracts from various biomedical journals published in the United States and worldwide. PubMed also provides access to citations for selected articles in life science journals not included in MEDLINE and additional relevant Web sites and links to molecular biology resources. The scope of MEDLINE includes such diverse topics as microbiology, delivery of health care, nutrition, pharmacology, and environmental health.

PubMed Homepage

The PubMed homepage includes a NCBI Header, Search Bar, and Footer that are common to all PubMed pages. The NCBI Header includes a NCBI Resources drop-down menu categorized by topic, a How To menu, and the Sign In for My NCBI. The Search Bar has the database selection menu, and includes a link to Advanced search and Help. Additional Search bar selections, RSS, and Save search, display after running a PubMed search. Popular tools and resources are under PubMed Tools (e.g., the Single Citation Matcher, Clinical Queries, and Topic-Specific Queries) and More Resources (e.g., MeSH Database, Journals Database, and Clinical Trials). The Footer includes links to many NCBI resources.

pubmed.gov
Searching PubMed

Enter your search term(s) into the search box and click the **Search** button for basic searching. To find an author, enter the author’s last name, then first and second initials (e.g., smith ja). Other search options include the following:

- To search for a journal, use the Journals Database—allows searching by topic, journal title/abbreviation, ISSN, or browsing by subject terms
- To build a search strategy with MeSH terms, use the MeSH Database—NLM-controlled Medical Subject Heading (MeSH) vocabulary provides a consistent way to retrieve information that may use different terminology for the same concepts
- To search for specific types of references, use either Clinical Queries or Topic-Specific Queries

Filters Sidebar

Narrow your search results using the Filters option. The Filters option sidebar will appear to the left of your results. To add additional filter categories to the sidebar, click the **Show additional filters** link, select the additional categories, and then click **Show**. To add filters to the sidebar for categories with many selections, click the category **more** … link. Multiple filters may be selected. A **Filters Activated** message will appear above the search results list. Filters remain in effect until removed. To deselect a filter, click the filter name again. To clear all of your filters selections, click **Clear all**.
Advanced Search

The Advanced search page provides three options to refine and focus a search: Search Builder, Search History, and More Resources. Search Builder allows creation of a search using Boolean operators. Using the All Fields selection will run search terms through the Automatic Term Mapping process, or a specific field may be selected to apply to the term. Search History tracks search statements and numbers them as links. Clicking on the numbered link provides a menu allowing search statements to be combined into a new search with the AND, OR or NOT Boolean operators, or to be run, deleted, examined in Details, or saved in My NCBI. More Resources provides links to the MeSH and Journals databases, Single citation Matcher, Clinical Queries, and Topic-Specific Queries.

Search Results

Search results initially display in a summary format in the order they were entered in PubMed as last in, first out. By default, the system displays 20 citations per page. Search results include the following:

► Links to related articles for all citations—click the Related Citations link below the citation
► Links to free full-text articles, if available,—click Free article below the citation
► Links to free full-text journal articles at Web sites of participating publishers—click Free Full-Text under Filter your results
► Links to other NLM resources for additional information—see on the right side of your Search Results page, Titles with your search terms, Free Full-text articles in PubMed Central (PMC), Find Related Data and other related information

To display the abstract for a journal article, click the title link. Some citations do not have abstracts and will include the note “No abstract available.”
My NCBI

My NCBI is an easy way to save and update searches on topics of continuing interest. You can choose filters that group your search results. Search updates will automatically be e-mailed to you if selected. To use My NCBI, your Web browser must accept cookies and allow pop-ups from NCBI Web pages. A cookie is information stored by a Web site server on your computer. The cookie retains user preferences such as search result filters, LinkOut displays, institutional icon links, document delivery services, etc. across user sessions. Users may opt out of the persistent cookie selection in their My NCBI settings at any time. Click My NCBI on the right side of the NCBI header to register with My NCBI.

Ordering Documents

NLM Loansome Doc is an automated document ordering program that allows PubMed users to order the full text of an article from a participating library. Before an order can be placed, and before a user can register, an agreement must first be established with a library that uses DOCLINE® (NLM automated interlibrary loan request and referral system). Users who are unsure about which library to contact may obtain assistance from the Regional Medical Library (RML) in their area by calling 1.800.338.7657, Monday-Friday, 8:30 a.m. - 5:00 p.m. in all time zones. To register with Loansome Doc go to https://docline.gov/loansome/login.cfm. During the online registration process, you will create a user account with your name, address, e-mail, and ordering preference.

From PubMed, registered Loansome Doc users can access Loansome Doc by performing a search, clicking the check box to the left of the articles they want to order, and selecting Order from the Send to drop-down menu.

Stay Connected

PubMed Mobile

PubMed Mobile provides a simplified, mobile-friendly Web interface to access PubMed. It includes the same basic search functionality and content as Standard PubMed; that is, all search terms and fields work similarly. ncbi.nlm.nih.gov/m/pubmed

PubMed for Handhelds

A Web site for searching MEDLINE with the Web browser of any mobile device. pubmedhh.nlm.nih.gov

E-mail Updates

Sign up for the NLM Technical Bulletin and received a once daily e-mail alert if an article is published or updated. service.govdelivery.com/service/subscribe.html?code=USNLMTB_1
Subscribe to PubMed RSS

PubMed New and Noteworthy will notify subscribers of enhancements to the PubMed, Journals, and MeSH databases.

PubMed-Alerts, an announcement-only list, will notify subscribers of major system problems with PubMed.
list.nih.gov/cgi-bin/wa.exe?SUBED1=pubmed-alerts&A=1

PMC News will notify subscribers of changes to the PMC system.
ncbi.nlm.nih.gov/feed/rss.cgi?ChanKey=PMCNews

Additional Resources

For further information, we recommend these additional resources:

► Non-English Guides to PubMed
  nnlm.gov/training/resources/intlpubmedlinks.html

► PubMed Online Training
  nlm.nih.gov/bsd/disted/pubmed.html

► PubMed Help (An online Help book)
  ncbi.nlm.nih.gov/books/NBK3830

► PubMed Tutorial
  nlm.nih.gov/bsd/disted/pubmedtutorial/index.html

► PubMed Update (Video)
  https://webmeeting.nih.gov/p64259100/

► PubMed Quick Tour: Simple Subject Search
  nlm.nih.gov/bsd/viewlet/search/subject/subject.html

► PubMed Quick Tour: Search for an Author
  nlm.nih.gov/bsd/viewlet/search/author/author.html

► CAM (Complementary and Alternative Medicine) on PubMed
  nnlm.gov/training/consumer/cam/cam-pubmed.pdf

► Getting Started with LinkOut (National Network of Libraries of Medicine)
  nnlm.gov/training/linkout
**MEDLINE® and MedlinePlus®: What Is the Difference?**

**MEDLINE** is the National Library of Medicine (NLM) premier bibliographic database. This Web-based research tool covers the fields of medicine, nursing, dentistry, veterinary medicine, the health care system, and the preclinical sciences. It contains citations and abstracts. Most of the articles found in MEDLINE are very technical and written for health care professionals. MEDLINE is available free through the NLM PubMed search system.

While MEDLINE is a source of medical research literature for health professionals, **MedlinePlus** provides health information especially written for consumers and patients by the National Institutes of Health and other reliable sources. MedlinePlus provides information on various health topics. Additionally, consumers can search for information in the online medical encyclopedia or medical dictionary, get information on prescription and over-the-counter medication, and obtain information on local physicians and dentists. MedlinePlus is not a database for references to journal articles.

Use this decision tree to choose the correct resource:

<table>
<thead>
<tr>
<th>MEDLINE</th>
<th>MedlinePlus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Directory</td>
</tr>
<tr>
<td>Journal citations</td>
<td>Selected links to Web resources</td>
</tr>
<tr>
<td>Professional biomedical literature</td>
<td>Web resources with authoritative health information</td>
</tr>
<tr>
<td>Health professionals</td>
<td>Patients, families, and consumers</td>
</tr>
<tr>
<td>Clinical terminology</td>
<td>Easy-to-understand language</td>
</tr>
<tr>
<td>Searchable database</td>
<td>Browse and search</td>
</tr>
</tbody>
</table>

**Value added:**
- Can be searched for free
- Selected full-text articles
- Links to some full-text journal articles via publishers' Web pages
- Selected consumer health journals
- Links to MedlinePlus
- Topic-specific queries
- Advanced search builder

**Value added:**
- Drug information
- Medical encyclopedia
- Links to other Web resources
- Link to MEDLINE searches
- Spanish version
- Surgery videos
- Multiple languages
PubMed®/MEDLINE® Search Exercises

Search Example: What information has been written about the correlation between coronary disease and HIV/AIDS?

Suggested Solution:

► Go to pubmed.gov
► Type coronary disease HIV AIDS in the Search box
► Click Search

► Click Show additional filters
► Select Subjects from the Additional filters box
► Click Show

► Select more.. under Subjects
► Select AIDS from the Subjects box
► Click Show

► Click AIDS
Search Exercises

Exercise 1: Locate citations on the role of social media in HIV prevention.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>social media HIV in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Click</td>
<td>Show additional filters</td>
</tr>
<tr>
<td>Select</td>
<td>Subjects in the additional filters pop-up box</td>
</tr>
<tr>
<td>Click</td>
<td>Show</td>
</tr>
<tr>
<td>Select</td>
<td>AIDS under Subjects</td>
</tr>
</tbody>
</table>

Active Filters appear above the search results.

Review the citation(s) retrieved.

To remove your filter selection, click Clear all next to the activated filter.

Click the Clear input (✓) button to the right in the search box to prepare for the next search.

The Filters Activated message is still displayed. Future searches will be limited to the AIDS subset of PubMed until the filter is cleared.
Exercise 2: Is the H1N1 (Swine Flu) vaccine safe for individuals with HIV?

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>h1n1 vaccine in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Click</td>
<td>AIDS under Subjects</td>
</tr>
<tr>
<td></td>
<td>Active Filters appear above the search results.</td>
</tr>
<tr>
<td>Review</td>
<td>the citation(s) retrieved</td>
</tr>
<tr>
<td>Click</td>
<td>the Clear input ( ) button to the right in the search box to prepare for the next search</td>
</tr>
</tbody>
</table>

Exercise 3: Locate articles that discuss Hepatitis C and HIV coinfection.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>hepatitis C HIV coinfection in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Filters Activated message is still displayed. You are still searching the AIDS subset of PubMed.</td>
</tr>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Review</td>
<td>citation(s) retrieved</td>
</tr>
</tbody>
</table>

Exercise 4: Locate articles that discuss whether pre-exposure prophylaxis (PrEP) can reduce a woman’s risk of becoming infected with HIV. Review related citations.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>pre-exposure prophylaxis in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Click</td>
<td>Show additional filters</td>
</tr>
<tr>
<td>Select</td>
<td>Sex and click Show</td>
</tr>
<tr>
<td>Click</td>
<td>Female under Sex</td>
</tr>
<tr>
<td>Review</td>
<td>the citation(s) and Related citations</td>
</tr>
<tr>
<td></td>
<td>To remove a specific filter selection, click clear next to it.</td>
</tr>
</tbody>
</table>
Exercise 5: Find articles that discuss pain management in HIV patients with peripheral neuropathy. Sort the results by publication date.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>pain management peripheral neuropathy in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Click</td>
<td>Display Settings and select Pub Date under Sort by</td>
</tr>
<tr>
<td>Click</td>
<td>Apply</td>
</tr>
<tr>
<td>Review</td>
<td>the citation(s) retrieved</td>
</tr>
</tbody>
</table>

Exercise 6: Locate articles that discuss taking Nevirapine for the prevention of mother-to-child HIV transmission. Limit retrieval to articles written in English and published in the past five years.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>nevirapine mother child transmission in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Click</td>
<td>5 years under Publication Date</td>
</tr>
<tr>
<td>Select</td>
<td>English under Language</td>
</tr>
<tr>
<td>Review</td>
<td>the citation(s) retrieved</td>
</tr>
</tbody>
</table>

To remove a specific filter selection, click clear next to it.

Exercise 7: Cytomegalovirus retinitis is common among people infected with HIV. What has been written about the use of Foscarnet and Ganciclovir in treating this disease in children?

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>cytomegalovirus retinitis foscarinet ganciclovir in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Note that the Limits Activated portal is still displayed. You must clear the filters you do not want for this search.</td>
</tr>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Click</td>
<td>Show additional filters</td>
</tr>
<tr>
<td>Select</td>
<td>Ages and click Show</td>
</tr>
<tr>
<td>Click</td>
<td>Child: Birth-18 years under Ages</td>
</tr>
<tr>
<td>Click</td>
<td>Search</td>
</tr>
<tr>
<td>Review</td>
<td>the citation(s)</td>
</tr>
</tbody>
</table>
Exercise 8: Locate an article written by J. Wooster titled “Opening up their doors: perspectives on the involvement of the African American faith community in HIV prevention in four communities.”

Suggested Solution:

- Click **Advanced**
- Type **African American faith** in the **Search** box
- Select **Author** from the **Search Builder** drop-down menu
- Type **wooster j** in the **Author** search box
- Click **Add to Search Box**
- Click **Search**
- Review the citation


Suggested Solution:

- Type **cultural competency** in the **Search** box
- Click **Search**
- Click the **checkbox** to the left of a record of your choice
- Select **E-mail** from the **Send to**: drop-down menu
- Select **Abstract (text)** from the **Format** drop-down menu
- Type e-mail address in the **E-mail** box
- Click **E-mail**

A confirmation e-mail sent message will be displayed above the results.

Exercise 10: Using PubMed Central (PMC), locate free full-text articles that discuss improved adherence to HAART.

Suggested Solution #1:

- Select **PMC** from the Search drop-down menu to the left of the search box
- Type **improved adherence haart** in the **Search** box
- Click **Search**
- Review the citation(s) and full-text article(s)
- Click **PubMed** at the bottom of the page under **Popular**
Suggested Solution #2:

Click **PubMed Central** at the bottom of the homepage under Popular

Type **improved adherence haart** in the Search box

Click **Search**

Review the citation(s) and full-text article(s)

Click **PubMed** at the bottom of the page under Popular

Exercise 11: Set up a My NCBI user account and conduct a search for journal articles discussing structured antiretroviral therapy interruption.

Suggested Solution:

Click **My NCBI** at the top right of the PubMed page

Click **Register for an account**

Follow the directions for setting up a username and password

A checked **Keep me signed in** box saves your My NCBI preferences on your computer in a persistent **cookie** file. It will also retain your password so that you do not need to sign in again. When using a public computer do not check this option.

Click **PubMed** in the list of databases at the top of the page

Type **structured antiretroviral therapy interruption** in the Search box

Click **Search**

Click **Save Search** at the top of the screen above the search box

Click **Save**

Select the e-mail update scheduling settings of your choice (optional)

Click **Save**

A confirmation e-mail sent message will be displayed above the results.
Saving and Printing Records in PubMed®

The **Send to:** button is available on screens with search results. You can save the entire results of a specific search or selected citations. If you don’t select specific citations before clicking on the **Send to:** button, you will create a file on your computer that will contain the entire search results, up to a maximum of 5,000 items. Most likely you don’t need all these files, so pay attention and select before you click.

You can also save records collected from multiple searches by using the **Send to: Clipboard** feature. The Clipboard holds a maximum of 500 items. When you save a file, your browser will prompt you where this file should be placed on your computer, and also give you the opportunity to rename the file.

**Saving Entire Search Results**

► Click **Send to**: File to select your formatting and sorting preferences

The default for the File feature is to save the entire retrieval—up to 5,000 items—unless you specifically select citations. For example, if you use the **Send to: File** feature on a screen displaying 1-20 items of 2,356, your saved file will contain all 2,356 citations. Make it a practice to select before you click.

► Click **Create File**

**Saving Selected Citations from a Single Search**

► Click the check box next to each citation you want to save

You can move to other pages within the search results to make more selections.

► Click **Send to**: File to select your formatting and sorting preferences

Saving a large retrieval may take several minutes. To save citations in html format, use the Save As function of your browser, and change the file extension to html. This will save only the citations displayed on the screen, so you may wish to consider changing the number of items per page from the Display Settings.

► Click **Create File**

**Using the Clipboard**

► Click the check box next to each citation you want to send to the Clipboard, select **Clipboard** from the **Send to:** drop-down menu. Click Add to Clipboard and those items selected will automatically be saved to the Clipboard.

Once you have added a citation to the Clipboard, the item will display a note, **Item in Clipboard** beneath the selected citation.
If you use the Clipboard feature without selecting citations using the check box(es), PubMed will add all of your search results—up to 500 citations—to the Clipboard. The Clipboard will be lost after eight hours of inactivity.

Your web browser must be set to accept cookies to use the Clipboard. A cookie is information stored by a web site server on your computer.

Citations in the Clipboard are represented by the search number “#0” and may be used in Boolean search statements. For example, to limit the citations you have collected in the Clipboard to English language citations, use the following search:

#0 AND English [la]

► This does not affect or replace the Clipboard contents

E-mailing Citations

► Select E-mail from the Send to: menu

► Select your formatting and sorting preferences

► Select the number to send (if sending more than the first 20 records)

► Enter an e-mail address

Only one is permitted, to prevent spam.

► Add additional text if you wish

► Click E-mail

Using My Bibliography

► Click the check box next to each citation you want to send to My Bibliography, select My Bibliography from the Send to: drop-down menu. Click Add to My Bibliography and follow the on-screen directions to add the selected items.

Using the Collections Feature

► Click the check box next to each citation you want to send to the Collections, select Collections from the Send to: drop-down menu. Click Add to Collections and follow the on-screen directions to add the selected items.

Collections are stored indefinitely and can continue to be built over time. There is no limit to the number of collections a user may store in My NCBI.
Ordering Full-text Articles

The **Order Documents** function allows you to order a full-text article from a medical library. Prior to using this feature, you must establish an agreement with a Loansome Doc participating library. During the registration process, you will have the opportunity to search for a Loansome Doc provider in your area (United States and international). Local fees may apply. To register, click **Order** from the **Send to:** menu, then **Order articles** to get to the **Loansome Doc Screen**, and then **Sign up!** from the Loansome Doc screen.

After you have registered with a Loansome Doc participating library, you can order citations by clicking the check box to the left of each citation you want to order. When you have finished marking your selections (you may move to other pages within your results), select **Order** from the **Send to:** drop-down menu.

You may use the Clipboard to collect items from multiple searches before ordering.

For some journals, full-text articles are available via a PubMed link to the publisher’s Web site. Publisher links for the full-text article are displayed on the Abstract or Citation display. **LinkOut** is a PubMed feature that links to outside sources for the full-text article (e.g., a publisher’s Web site), as well as other resources such as biological databases and sequencing centers. User registration, a subscription fee, or some other type of fee may be required to access full-text articles in some journals.

Exporting Citations into a Reference Manager Program

To export your search results into a reference manager program, select **File** from the **Send to:** drop-down menu. Select the MEDLINE format to download records for use with reference management software.

Consider changing the .fcgi extension to .txt if you wish to open the file in a text editor, word processor, or reference manager program.

Printing Your Search Results

To print your search results, use the print function of your Web browser. Before printing, consider using the **Display Settings** feature to increase the number of documents per page so that the total number of documents is displayed on one page (maximum: 200 per page). You can print only the citations from the displayed page.

To print selected items from one or more searches on a single page, use the Clipboard feature first to collect them.
Public Health Partners
Public Health Partners

Partners in Information Access for the Public Health Workforce (PHP) is a collaboration of U.S. government agencies, public health organizations, and health sciences libraries dedicated to providing timely, convenient access to selected public health resources on the Internet. Their mission is to help the public health workforce find and use information effectively to improve and protect the public’s health.

phpartners.org

The Partners

- Agency for Healthcare Research and Quality (AHRQ)
- American Public Health Association (APHA)
- Association of Schools of Public Health (ASPH)
- Association of State and Territorial Health Officials (ASTHO)
- Centers for Disease Control and Prevention (CDC)
- Health Resources and Services Administration (HRSA)
- Medical Library Association (MLA)
- National Agricultural Library (NAL)
- National Association of County and City Health Officials (NACCHO)
- National Association of Local Boards of Health (NALBOH)
- National Library of Medicine (NLM)
- National Network of Libraries of Medicine (NN/LM)
- Public Health Foundation (PHF)
- Society for Public Health Education (SOPHE)
Content

The PHP Web site provides links to information on specific topics. Public health topics, which can be selected from the Public Health Topics drop-down menu, are Bioterrorism, Dental Public Health Environmental Health, HIV/AIDS, How to Access Journal Articles, Nutrition, Obesity, Public Health Genomics, Veterinary Public Health, and Workforce Development.

Main Topics linked on the homepage are Health Promotion and Health Education, Literature and Guidelines, Health Data Tools and Statistics, Grants and Funding, Education and Training, Legislation and Policy, Conferences and Meetings, Finding People, Discussion, E-mail Lists, and Jobs and Careers.

Links to Latest News items can be found on the homepage. Links are also provided to partner-supported initiatives, including the Public Health Information and Data Tutorial and Training Manual, the Healthy People 2020 Information Access Project, the Resource Guide for Public Health Preparedness, and the CPH (Certified for Public Health) Study Guide.

Stay Connected

Subscribe to RSS

Really Simple Syndication (RSS) provides notification when new links and public health news items are added to PHPPartners.org. phpartners.org/rss_phppartners.xml

Get E-mail Updates

Subscribe to the PHPPARTNERS_LINK list to receive the weekly announcement-only list of new resources. list.nih.gov/cgi-bin/wa.exe?SUBED1=phppartners_link&A=1

Additional Resources

For further information, we recommend these additional resources:

► Partners in Information Access for the Public Health Workforce Fact Sheet
  nlm.nih.gov/nno/partners.html

► Public Health Information and Data Tutorial
  phpartners.org/tutorial/index.html

► Public Health Information and Data: A Training Manual
  phpartners.org/phpmanual.html
Public Health Partners Search Exercises

Search Example: Find resources for state HIV/AIDS statistics.

► Go to phpartners.org

► Select HIV/AIDS under Public Health Topics Pages

► Click Health Data Tools and Statistics in the list of topics under HIV/AIDS

► Click State Health Facts: HIV/AIDS

► Use the browser’s Back button to return to the Public Health Partners (PHP) Web site
Search Exercises

Exercise 1: Using the search box find information on the Healthy People 2020 initiative.

Suggested Solution:

<table>
<thead>
<tr>
<th>Type</th>
<th>healthy people 2020 in the Search box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Go</td>
</tr>
<tr>
<td>Review</td>
<td>the resources retrieved</td>
</tr>
<tr>
<td></td>
<td>Use the browser’s Back button to return to the Public Health Partners (PHP) Web site.</td>
</tr>
<tr>
<td>Click</td>
<td>Home at the top of the PHP page to prepare for the next search</td>
</tr>
</tbody>
</table>

Exercise 2: Review the HIV funding opportunities for community outreach initiatives.

Suggested Solution:

<table>
<thead>
<tr>
<th>Click</th>
<th>HIV/AIDS under Public Health Topic Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Grants and Funding in the list of topics under HIV/AIDS</td>
</tr>
<tr>
<td>Click</td>
<td>AIDS Community Information Outreach Projects</td>
</tr>
<tr>
<td></td>
<td>Use the browser’s Back button to return to the PHP Web site.</td>
</tr>
<tr>
<td>Click</td>
<td>Home at the top of the PHP page</td>
</tr>
</tbody>
</table>

► Click Home at the top of the PHP page to prepare for the next search.
Exercise 3: Subscribe to a HIV/AIDS e-mail communication.

Suggested Solution:
- Click **HIV/AIDS** under **Public Health Topic Pages**
- Click **Discussion and E-mail Lists** in the list of topics under **HIV/AIDS**
- Review the resource(s) of your choice and follow the online instructions to subscribe (optional)
- Use the browser’s **Back** button to return to the PHP Web site.
- Click **Home** at the top of the PHP page

Exercise 4: Locate food deserts (low-income communities without ready access to healthy and affordable food) in your city.

Suggested Solution:
- Click **Nutrition** under **Public Health Topic Pages**
- Click **Data and Statistics** in the list of topics under **Nutrition**
- Click **Food Desert Locator** (U.S. Department of Agriculture (USDA))
- Click **Enter the map** and follow the online instructions
- Use the browser’s **Back** button to return to the PHP Web site.
- Click **Home** at the top of the PHP page

Exercise 5: I’m planning to travel outside of the country. What risks are associated with drinking water in a foreign country?

Suggested Solution:
- Click **Environmental Health** under **Public Health Topic Pages**
- Click **Water** in the list of topics under **Environmental Health**
- Click **MedlinePlus-Drinking Water** (National Library of Medicine (NLM) U.S.)
- Click **Related Issues** under **Learn More**
- Click **Water Disinfection for Travelers** (Centers for Disease Control and Prevention)
- Review the information retrieved and close the CDC pop-up window
- Use the browser’s **Back** button to return to the PHP Web site.
- Click **Home** at the top of the PHP page
Exercise 6: Find resources for state health data.

Suggested Solution:

<table>
<thead>
<tr>
<th>Select</th>
<th>Health Data Tools and Statistics under Main Topics Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>State Health Data under Health Data Tools and Statistics</td>
</tr>
<tr>
<td>Review</td>
<td>the resource(s) of your choice</td>
</tr>
<tr>
<td></td>
<td>Use the browser’s Back button to return to the PHP Web site.</td>
</tr>
<tr>
<td>Click</td>
<td>Home at the top of the PHP page to prepare for the next search</td>
</tr>
</tbody>
</table>
DIRLINE®

DIRLINE is the National Library of Medicine online database containing location and descriptive information about a wide variety of information resources including organizations, research resources, projects, and databases concerned with health and biomedicine. This information may not be readily available in bibliographic databases. Each record may contain information on the publications, holdings, and services.

dirline.nlm.nih.gov

DIRLINE focuses primarily on health and biomedicine, although it also provides limited coverage of some other special interests. Topics include HIV/AIDS, maternal and child health, most diseases and conditions including genetic and other rare diseases, health services research, and technology assessment. The information resources fall into many categories including the following:

► Federal, state, and local government agencies
► Information and referral centers
► Professional societies
► Self-help groups and volunteer associations
► Academic and research institutions and their programs
► Information systems and research facilities
Searching DIRLINE

Search DIRLINE using subject words (such as the name of a disease or condition, or the name or location of a resource). Keep the search simple to maximize retrieval. Refine your search by including Medical Subject Headings (MeSH®). MeSH consists of sets of specific terms developed by NLM to enhance searching.

For a list of health organizations, click **A-Z List of Health Organizations** under Support Page on the homepage.

Mobile Tools and Service

**Health Hotlines App**

Mobile access to the directory of organizations with toll-free telephone numbers from an iPhone, iPod touch, and iPad. [itunes.apple.com/app/health-hotlines/id376404746?mt=8](http://itunes.apple.com/app/health-hotlines/id376404746?mt=8)

**DIRLINE API**

Offers a RESTful Web Service Application Programming Interface (API) that allows users to search the DIRLINE database with keywords. This service returns search results with brief and full records in DIRLINE API Response Format. [dirline.nlm.nih.gov/dirlineapi/DIRLINEWebService.html](http://dirline.nlm.nih.gov/dirlineapi/DIRLINEWebService.html)

**DIRLINE Search for Disaster Organizations Widget**

The widget provides the graphic with links and it will search the DIRLINE database for organizations focused on disasters. [disaster.nlm.nih.gov/dimrc/widgetdimrc.html](http://disaster.nlm.nih.gov/dimrc/widgetdimrc.html)
Additional Resources

For further information, we recommend these additional resources:

► **DIRLINE Fact Sheet**
nlm.nih.gov/pubs/factsheets/dirlinfs.html

► **Health Hotlines** a compilation of organizations with toll-free telephone numbers. It is derived from **DIRLINE**
healthhotlines.nlm.nih.gov/index.html

► **Prescription for Success: Consumer Health Information on the Internet**
(National Network of Libraries of Medicine).
nnlm.gov/training/consumer/prescription
This page was intentionally left blank.
DIRLINE Search Exercises

Search Example: Find HIV/AIDS-related resources. Review several resources of interest to you.

Suggested Solution:

► Go to dirline.nlm.nih.gov
► Type HIV AIDS in the Search box
► Click Search

► Review the record(s) of your choice by clicking the organization name

► Click Search Results to return to the search results page

► New Search to prepare for the next search
Search Exercises

Exercise 1: Find health information resources that are located in your state.

Suggested Solution:

Type state name in the Search box
Click Search
Review the record(s) of choice
Click New Search button on the left side of the screen to prepare for a new search

Exercise 2: Are there any organizations that offer information on nutrition? Save records that are of interest to you.

Suggested Solution:

Type nutrition in the Search box
Click Search
Click the check box to the left of record(s) of your choice
Click Save Checked Items button on the left of the page
Click Displayed Saved Items button to review the record(s)
Click New Search button on the left to prepare for the next search

Exercise 3: Find records for organizations that provide information on gender violence.

Suggested Solution:

Type gender violence in the Search box
Click Search
Review record(s) of your choice
Click New Search to prepare for the next search

After reviewing a record, click Search Results to return to the search results page.
Exercise 4: Find HIV/AIDS-related organizations that focus their efforts on minority groups. Next, limit the search to organizations with services for the hearing impaired.

Suggested Solution:

Type AIDS minority groups in the Search box  
Select Exact Phrase  
Using exact phrase will get the most specific retrieval, but may limit your search results.  
Click Search  
Review record(s) of your choice  
Click Modify Search  
Select Only organizations with services for the hearing impaired under Select records containing:  
Click Search  
Review record(s) of your choice  
Click New Search to prepare for the next search

Exercise 5: Locate information on the Ryan White Care Act.

Suggested Solution:

Type ryan white in the Search box  
Click Search  
Review record(s) of your choice  
Click New Search on the left to prepare for the next search

Exercise 6: Find records for the various Centers for Disease Control and Prevention (CDC) HIV/AIDS programs.

Suggested Solution:

Type cdc HIV AIDS in the Search box  
Click Search  
Review Record(s) of your choice  
Click New Search to prepare for the next search
Exercise 7: Use the Browse Index feature to identify the number of organizations that offer information on gay and lesbian health. Sort the records in descending order.

Suggested Solution:

Click **Browse the Index**
Type *gay* in the **Search** box
Click **Search**
Click the check box for *gay* under **index term**
Click **Select** above the table
Click **Sort** on the left
Select **Descending** order
Click **Sort**
Review record(s) of your choice
Click **New Search** to prepare for the next search

Exercise 8: Locate organizations that provide information on emergency preparedness.

Suggested Solution:

Type *emergency preparedness* in the **Search** box
Click **Search**
Review record(s) of your choice
Click **New Search** to prepare for the next search
Additional Resources

► National Minority AIDS Council
► Office of AIDS Research
► Selected CDC Web Sites
► Selected Internet Resources in HIV/AIDS
► Selected Internet Resources in Health
National Minority AIDS Council

The National Minority AIDS Council (NMAC) is the premier national organization dedicated to developing leadership within communities of color to address the challenges of HIV/AIDS.

nmac.org

Programs and Training

► HIV/AIDS Stigma Program
► Individualized Capacity Building Assistance
► Prison Initiative
► Supporting Network of HIV CARE (SNHC) by Enhancing Primary Medical Care (EPMC)
► Equal Access Initiative Computer Grants Program
► Women of Color Leadership Institute
Tools and Resources

► Online Resource Library
► NMAC E-Alerts
► NMAC/POZ AIDS Services Directory
► Grant Writing Tool
► NMAC Publications Resource Center (order small quantities of NMAC publications free of charge)
► NMAC Publication Download Library
► Calendar of Events
Office of AIDS Research

The Office of AIDS Research (OAR), National Institutes of Health (NIH), plans, coordinates, evaluates, and funds all NIH AIDS research and promotes collaborative research activities. Information on the Web site includes web broadcasts and minority initiatives.

www.oar.nih.gov

Strategic Plan
► Trans-NIH Plan for HIV-Related Research

HIV/AIDS Information (links)
► U.S. and Global Statistics
► Treatment and Prevention Guidelines
► CDC Interim Guidance regarding HIV infection and Swine Origin Influenza A (H1N1) virus
► Clinical Trials Information
► National Institute of Allergy and Infectious Diseases (NIAID) AIDS Information
► National Library of Medicine Resources
► Other NIH Institutes and Centers AIDS Programs
► Other Federal and International HIV/AIDS Programs
► Research on AIDS Benefits Efforts Against Diseases (information page)
Centers for Disease Control and Prevention

CDC.gov is the Centers for Disease Control and Prevention’s primary online communication channel. The Web site includes an A-Z Index of health topics and links to publications. Information is available for individuals interested in health issues, public health professionals, researchers, media, and health care providers. The Multimedia & Tools section includes podcasts, RSS feeds, image library, a BMI (Body Mass Index) calculator, and training information. CDC.gov is also available in multiple languages.

Recommended Sections

► Health Disparities
cdc.gov/omhd/Topic/HealthDisparities.html

► Health Equity: A Selected Bibliography
cdc.gov/nccdphp/publications/healthdisparities

► Tools and Training
cdc.gov/healthyouth/tools/index.htm
This page was intentionally left blank.
Selected Internet Resources in HIV/AIDS

AIDS.GOV
aids.gov

AIDS Action Committee of Massachusetts
aac.org

AIDS Education Global Information System (AEGIS)
www.aegis.org

AIDS History Project
library.ucsf.edu/collections/archives/manuscripts/aids

AIDS Images Library
aids-images.ch

AIDS Information and Controversy 1985–1995
aidsinfobbs.org

AIDS InfoNet
aidsinfonet.org

AIDS Project Los Angeles
apla.org

AIDS Resource List
specialweb.com/aids

AIDS Treatment Data Network
atdn.org

AIDS Treatment News
thebody.com/content/art31573.html

AIDSinfo
aidsinfo.nih.gov

Aidsmap
aidsmap.com

All the Virology on the WWW
virology.net/garryfavweb.html

American Foundation for AIDS Research (amfAR) Global Link
amfar.org/globallink

American Red Cross
redcross.org

Australian Federation of AIDS Organisations
afao.org.au

The Body
thebody.com
California AIDS Clearinghouse
tagaycenter.org

Canadian AIDS Treatment Information Exchange
catie.ca

Canadian HIV Trials Network
www.hivnet.ubc.ca/e/home

Center for AIDS Prevention Studies
caps.ucsf.edu

Centers for Disease Control and Prevention (CDC) HIV/AIDS
cdc.gov/hiv

Critical Path AIDS Project
critpath.org

GMHC on the Web Gay Men’s Health Crisis
gmhc.org

Healthfinder.gov
healthfinder.gov

Health Resources and Services Administration (HRSA) HIV/AIDS Program:
Caring for the Underserved
hab.hrsa.gov

Health Services/Technology Assessment Text (HSTAT)
ncbi.nlm.nih.gov/books/bv.fcgi?rid=hstat

HIV Databases
hiv.lanl.gov

HIV InSite
hivinsite.ucsf.edu

HIV/AIDS Surveillance (U.S. Census Bureau)
census.gov/ipc/www/hivaidsn.html

HIV/AIDS Vaccines
www.niaid.nih.gov/topics/HIVAIDS/research/vaccines

HIVandHepatitis.com
hivandhepatitis.com

HIVdent (dental information)
hivdent.org

HIVpositive.com
hivpositive.com

How to Find Reliable HIV/AIDS Treatment Information on the Internet
sis.nlm.nih.gov/outreach/hivaidstreatmentmanual.pdf
International AIDS Society
iasociety.org

International Association of Physicians in AIDS Care
iapac.org

Johns Hopkins HIV Guide
hopkinsguides.com/hopkins/ub/index/Johns_Hopkins_HIV_Guide/All_Topics/A

Joint United Nations Programme on HIV/AIDS
unaids.org

MedlinePlus AIDS
medlineplus.gov/aids

Medscape HIV/AIDS
medscape.com/hiv

National AIDS Treatment Advocacy Project (NATAP)
natap.org

National Clearinghouse for Alcohol and Drug Information
ncadi.samhsa.gov

National HIV/AIDS Clinicians’ Consultation Center (NCCC)
nccc.ucsf.edu

National Institute of Allergy and Infectious Diseases (NIAID)
www.niaid.nih.gov

National Institutes of Health (NIH) Office of AIDS Research (OAR)
www.oar.nih.gov

National Library of Medicine HIV/AIDS Portal
sis.nlm.nih.gov/hiv.html

National Minority AIDS Council
nmac.org

National Prevention Information Network
cdnpin.org

New York Academy of Medicine, HIV/AIDS Information Outreach Program
aidsnyc.org

NIAID Division of Acquired Immunodeficiency Syndrome
www.niaid.nih.gov/about/organization/daids

Partners in Information Access for the Public Health Workforce—HIV
phppartners.org/hp/hiv.html

Positive.org
positive.org/Home

Project Inform
projinf.org
PubMed
pubmed.gov

PubMed Training Manual (NLM)
nlm.nih.gov/pubs/web_based.html

PubMed Tutorial (NLM)
nlm.nih.gov/bsd/disted/pubmedtutorial

Rural Center for AIDS/STD Prevention
indiana.edu/~aids

San Francisco AIDS Foundation
sfaf.org

Social Security Administration
ssa.gov

U.S. Department of Health and Human Services
hhs.gov

U.S. Food and Drug Administration, HIV and AIDS
www.fda.gov/oashi/aids/hiv.html

World Health Organization, Tuberculosis
who.int/tb/en

Yahoo AIDS/HIV Resources
dir.yahoo.com/health/diseases_and_conditions/aids_hiv
Selected Internet Resources in Health

Agency for Healthcare Research and Quality
ahrq.gov
—Although this Web site is primarily for health care professionals, it also contains a section on consumer health. Other topics include Clinical Information, Funding Opportunities, Research Findings, Specific Populations, Public Health Preparedness, Data & Surveys, and Quality and Patient Safety.

American Medical Association
ama-assn.org
—Information for physicians, doctor and hospital finders, the Journal of the American Medical Association, and health and fitness information.

BioMed Central
biomedcentral.com/browse/journals
—Free access to a wide variety of more than 100 journals and other services. The Quick Search feature allows searching of BioMed Central, and also PubMed and PubMed Central.

CDC Diseases and Conditions
cdc.gov/DiseasesConditions
—An index of diseases, conditions, concerns, and programs from the Centers for Disease Control and Prevention. Includes links to publications, news and events, and related CDC organizations.

CDC Environmental Health
cdc.gov/environmental
—Informs the general public about environmental health. Topics include food safety, extreme cold, hydrocarbons, lead poisoning, mold, and carbon monoxide. Under Featured Items see links for upcoming events and recently released reports on environmental health topics. From the Centers for Disease Control and Prevention.

Center for Drug Evaluation and Research
www.fda.gov/cder
—This site includes information about prescription and over-the-counter drugs, drug safety, and links to major drug information pages. From the U.S. Food and Drug Administration.

ClinicalTrials.gov
clinicaltrials.gov
—Developed by the National Institutes of Health through its National Library of Medicine to provide patients, family members, and members of the public current information about clinical research studies. It is updated regularly.
CNN Health
cnn.com/HEALTH
—Health links to Cable News Network news stories regarding health concerns.

Directory of Open Access Journals
www.doaj.org
—Provides access to free, full-text, quality-controlled scientific and scholarly journals. Journals may be browsed by title or subject; many are searchable at article level.

Doctor's Guide
docguide.com
—A comprehensive source of links to medical information of interest to physicians, as well as information and resources a doctor may want to recommend to patients. Includes news stories, a list of webcasts and continuing medical education (CME) opportunities, case studies, and the Congress Resource Center, a database of meetings with links to relevant travel planning information.

U.S. Food and Drug Administration
www.fda.gov
—Provides links to FDA resources, including research information on food, drugs, biologics, cosmetics, medical devices, tobacco, and toxicology.

Health Disparities/CDC
cdc.gov/omhd/Topic/HealthDisparities.html
—Links to extensive information on health disparities organized on the homepage by Topics, Quick Links, Key Resources, Programs and Campaigns, and other features.

Health Hotlines
healthhotlines.nlm.nih.gov
—A National Library of Medicine online database of health-related organizations operating toll-free telephone services.

Health Literacy Training (FREE)
hrsa.gov/publichealth/healthliteracy/index.html
—The U.S. Department of Health and Human Services, Health Resources and Services Administration, offers to health providers this free online training titled Unified Health Communication 101: Addressing Health Literacy, Cultural Competency, and Limited English Proficiency. The course has five modules, takes about five hours to complete, and can be completed at your own pace. Credits can be elected for CEU/CE, CHES, CME, or CNE.
**Healthfinder**  
[healthfinder.gov](http://healthfinder.gov)  
—A Web site of the U.S. government with links to accurate, reliable consumer health information.

**Healthy People 2020**  
[healthypeople.gov](http://healthypeople.gov)  
—A health initiative for the nation coordinated by the Office of Disease Prevention and Health Promotion of the U.S. Department of Health and Human Services. The overarching goals of Healthy People 2020 are to increase quality and years of healthy life and to eliminate health disparities. It is designed to be used by people on many levels—personal, community, state, and national.

**Healthy People 2010 Information Access Project**  
[phpartners.org/hp](http://phpartners.org/hp)  
—A Web resource developed by the National Library of Medicine with assistance from subject experts and public health librarians. The site provides “pre-formulated” PubMed searches for selected Healthy People 2010 focus areas to make current information and evidence-based strategies related to the HP2010 objectives easier to find. It provides links to relevant full-text resources on NLMs Web site. This site is a pilot project funded by the National Library of Medicine with assistance from the Public Health Foundation and the National Network of Libraries of Medicine. Feedback is requested for project expansion to all HP2010 focus areas.

**Healthy Schools Healthy Youth**  
[cdc.gov/healthyyouth/](http://cdc.gov/healthyyouth/)  
—The Centers for Disease Control and Prevention’s Division of Adolescent and School Health Web site provides tools and resources to promote school health.

**Medical Matrix**  
[medmatrix.org/reg/register.asp](http://medmatrix.org/reg/register.asp)  
—A physician peer-reviewed list with useful topical and specialty categorizations. It contains useful links to MEDLINE, CME, and online publications. Registration is required.

**MedicineNet**  
[medicinenet.com](http://medicinenet.com)  
—A network of physician educators dedicated to providing up-to-date, quality medical information for the public. Links from this site include subject areas such as HealthNews of the week, Diseases & Conditions, Image Collection, Symptom Checker, Med Terms Dictionary, and Medication Information.
MedlinePlus
medlineplus.gov
—A consumer health Web site from the National Library of Medicine, provides health professionals and consumers a wealth of authoritative, up-to-date medical information on diseases and medical conditions. Resources include lists of hospitals and physicians, a medical encyclopedia, a medical dictionary, extensive information on prescription and nonprescription drugs, health information from the media, and links to thousands of clinical trials. MedlinePlus is updated daily. Available in English and Spanish.

Medscape®
medscape.com
—Medscape, from WebMD®, offers integrated medical information and education tools to medical specialists, primary care physicians, and other health professionals. Key features include physician-optimized MEDLINE, CME activities, conference coverage, daily professional medical news in your specialty, and the Internet’s first primary-source medical journal, Medscape General Medicine. A one-time, free registration allows Medscape to automatically send the specialty page that best fits your profile.

My Family Health Portrait
familyhistory.hhs.gov
—A tool from the U.S. Surgeon General that allows users to create a family tree (drawing) and a personalized family health history report from any computer with an Internet connection and an up-to-date browser. Focus is on six common diseases: heart disease, stroke, diabetes, colon cancer, breast cancer, and ovarian cancer. Other conditions that are of particular interest to the family can be included. Also, the drawing and the report can be printed and shared with family members and personal physicians. Also available in Spanish, Italian, and Portuguese.

National Library of Medicine®
nlm.nih.gov
—The National Library of Medicine (NLM), on the campus of the National Institutes of Health in Bethesda, Maryland, is the world’s largest medical library. The library collects materials and provides information and research services in all areas of biomedicine and health care.

National Library of Medicine Free Biomedical Literature Resources
nlm.nih.gov/docline/freehealthlit.html
—This National Library of Medicine Web site offers links to a number of free biomedical literature resources, including PubMed®, NCBI Bookshelf, the Public Library of Science, BioMed Central, and the Directory of Open Access Journals.

National Medical Association
nmanet.org
—Focuses primarily on health issues related to African Americans and medically underserved populations. Links include Continuing Medical Education (CME), Journal of the National Medical Association (JNMA), and Health Policy.
National Women’s Health Information Center
womenshealth.gov
—This site offers information on more than 800 health topics specifically for women and it operates a call center. Includes information on special populations and information in Spanish. From the U.S. Department of Health and Human Services, Office on Women’s Health.

NIH Health Information
health.nih.gov
—From the National Institutes of Health. Includes quick links to Child & Teen Health, Men’s Health, Minority Health, Seniors’ Health, Women’s Health, and Wellness & Lifestyle.

NursingNet
nursingnet.org
—Provides a forum for medical professionals and students to obtain and disseminate information about nursing and medically related subjects.

Office of Minority Health, U.S. Department of Health and Human Services
minorityhealth.hhs.gov
—Serves as a national resource and referral service on minority health issues for health professionals, consumers, grantseekers, students, and the media. Online resources include publications, funding announcements, and links to federal/state/local government agencies, educational institutions, nonprofit/national advocacy/private organizations, and minority group health sites.

Public Health Partners (PHP)
phppartners.org
—A collaboration of U.S. government agencies, public health organizations, and health science libraries. The site provides links to health resources in the areas of Health Promotion and Education, Literature and Guidelines, Health Data Tools and Statistics, Grants and Funding, Education and Training, Legislation, Conferences and Meetings, Finding People, Discussion and E-mail Lists, and Jobs and Careers.

Public Health Information and Data Tutorial
phppartners.org/tutorial
—This tutorial from Public Health Partners (PHP) provides instruction on issues related to information access and management. Clear connections are established to recognized competencies in public health, and examples are included which represent much of the diversity inherent in the practice of public health. Content contributors and authors represent city, county, state, and federal agencies.

National Clearinghouse for Alcohol and Drug Information
ncadi.samhsa.gov
—Current and comprehensive information about substance abuse prevention and addiction treatment from the Substance Abuse and Mental Health Services Administration (SAMHSA).
Public Library of Science  
[plos.org/journals](plos.org/journals)
—Provides free online access to original published reports of ideas, discoveries, and research results in the life sciences and medicine. The journals are searchable online and also available in print.

PubMed®  
[pubmed.gov](pubmed.gov)
—One of NLM’s free search services. It provides access to citations in MEDLINE® with links to participating online journals.

Rural Assistance Center State Resources  
[raonline.org/states](raonline.org/states)
—The Rural Assistance Center (RAC) is an information portal established by the U.S. Department of Health and Human Services’ Rural Initiative. Its objective is to provide rural communities and stakeholders access to the full range of programs, funding, and research available to enable them to provide quality health and human services to rural residents.

Virtual Pediatric Hospital  
[virtualpediatrichospital.org](virtualpediatrichospital.org)
—Virtual Pediatric Hospital is a digital library of pediatric information and is the Apprentice’s Assistant™.

WebMD  
[webmd.com](webmd.com)
—Provides a wide range of online health information for health care professionals and consumers. WebMD Health® includes consumer health information, health and wellness news, support communities, and interactive health management tools. Medscape® from WebMD provides clinical information and educational tools for health care professionals, including online continuing education, online coverage of medical conferences, access to more than 100 medical journals, and daily medical news.

WholeHealthMD  
[wholehealthmd.com](wholehealthmd.com)
—A complementary and alternative medicine Web site that is dedicated to providing the best in integrative health and wellness solutions. All material has been reviewed and developed by board-certified doctors. The Healing Center section of the site provides overviews on a wide range of conditions. Other sections include Healing Kitchen, Expert Opinions, Reference Library, News and Perspectives, and Supplement.
Savvy Health Surfing
Questions to Ask About Health-Related Web Sites

Authority and Accuracy
► Who is the author or source?
► Can you verify their credentials?
► Do they represent a recognized organization or is it a personal page?
► Is affiliation information provided?
► Does the Web site have an advisory board?
► Can the information be verified through links to the sources?
► If the site offers advice, do qualified health professionals provide it?
► Is contact information provided?

Coverage
► Who is the intended audience for this site?
► What is the purpose of the site?
► Does the site promote or advocate a viewpoint?
► Is the depth of coverage on the site reasonable?
► Is the information primary or secondary?
► If appropriate, are there links to additional information?

Currentness
► When was the site created?
► When was the site last updated?
► When was the data or information collected?
► Are the links kept up to date?

Objectivity
► Is the purpose of the site clearly stated?
► Is the information presented objectively?
► Is any sponsorship clearly acknowledged?

Design Features
► Is the site well-organized and user-friendly?
► Is the site easy to navigate?
► Is the graphic layout of the site pleasing? Is it clear and uncluttered?
► Are there any features that increase or decrease usability? Do you need additional viewers or plug-ins?
► Is there an internal search engine on the site?
► Are there customizable options?
► Can you ask questions or provide feedback?
► Is the site accessible to individuals with disabilities?
Contact the National Library of Medicine for Database Assistance

Toll-free: 888.FIND.NLM (346.3656)
E-mail: custserv@nlm.nih.gov

Online Resources

<table>
<thead>
<tr>
<th>National Library of Medicine Training Center</th>
<th>nnlm.gov/ntc</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLM HIV/AIDS Training Resources</td>
<td>sis.nlm.nih.gov/outreach/training_exhibits.html</td>
</tr>
<tr>
<td>Promotional Materials</td>
<td>sis.nlm.nih.gov/outreach/promotional_materials.html#hiv</td>
</tr>
<tr>
<td>Fact Sheets</td>
<td>nlm.nih.gov/pubs/factsheets/factsheets.html</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>nlm.nih.gov/services/faq.html</td>
</tr>
</tbody>
</table>

See Help and FAQ links on each database homepage.

The National Network of Libraries of Medicine

Toll-free number for all Regional Medical Libraries: 800.338.7657
Monday-Friday 8:30 a.m. – 5:00 p.m. in all time zones

Web site: nnlm.gov